
 

994-T074 Rev A  – June 2015  i 

WS1800 Manager 

994-T074 Rev A  –  June 2015 
 



 

ii  994-T074 Rev A  –  July 2015 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
Westronic Systems 
200, 550 71 Avenue SE 
Calgary, AB, Canada T2H 0S6 
Phone (403) 250-8304 
Fax (403) 263-2174 
 
 
All rights reserved.  No portion of this manual may be copied, reproduced or duplicated in 
any manner without prior permission from Westronic Systems. 
 
This manual is based on information available at the time of publication.  While every effort 
has been made to ensure its accuracy, the information contained herein may not cover all 
details or variations in hardware or software, nor may it provide every possible detail in 
connection with installation and operation. 
 
The information contained in this document is confidential to Westronic Systems and its 
owners.  The recipient of this information by its retention and use agrees to the confidential 
status of this the information contained herein. 
 
© Westronic Systems 2015. 
 
 
 



 

994-T074 Rev A – July 2015  iii 

Revision History 
 

Software Version Date Author Comments 

3.3.1 and up 01-06-2015 PL Initial Customer Release 

    

 



 

iv  994-T074 Rev A  –  July 2015 

 

This page was intentionally left blank. 

 



WS1800 Manager — About this document 

994-T074 Rev A  – June 2015  v 

About this document 

This manual provides detailed information on the WS1800 Manager software package for 

configuring the WS1800 RTU. 

This manual is divided up into the following main sections: 

Overview — this section describes the function of the WS1800 Manager software 

application. 

System Requirements — this section describes the minimum requirements needed on 

your PC in order to run the application. 

Getting Started — this section describes the basics of using 1800
 
Manager.  Some of the 

topics covered are how to start and exit the application and how to work within the 

application.  

WS1800 Manager Tabs— this section describes function and features of the various tabs 

available in WS1800 Manager. 

Upgrading WS1800 Firmware through Manager— this section describes the remote 

firmware upgrade process. 

Other Manager Features — this section describes how to save a configuration to file, load 

a saved file to a WS1800 and how to import/export point files. 
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Overview 

1800 Manager is a single RTU application, where only one RTU can be configured at a 

time.  The user may connect to a WS1800, upload the current configuration, make 

changes, and download the changes back to the RTU. 

 Network Database – 1800 Manager’s RTU database can be stored either locally or on 

a network drive.  1800 Manager installation can be configured with a list of database 

partitions from which the user can select a database to use. 

 

The 1800 Manager software package is used to: 

 Connect and Upload the configuration on the RTU to the PC. 

 Download the configuration from the PC to the RTU. 

 Input or change the license key configuration of the WS1800 

 Configure the communications parameters on the RTU. These parameters include IP, 

router and netmask addresses for a LAN connection and/or a Line Modem 

connection. 

 Configure the serial port(s) on the RTU, their respective communication settings (data 

bits, parity, stop bits, and baud rate). 

 Configure the WS1800 to report to a Host Management System via Simple Network 

Management Protocol (SNMP). 

 Configure the point definitions for the discrete inputs. 

 Configure the point definitions and alarm thresholds for the analog inputs (if the RTU 

is so equipped). 

 Configure the point definitions and alarm thresholds for the temperature/humidity 

inputs (if the RTU is so equipped). 

 Backup and Restore WS1800 configuration files. 

 Upgrade the version of firmware running on the RTU. 

 

 

 

Chapter 
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System Requirements 

To run 1800 Manager on your PC, you will require: 

 Windows 98/ME/2000/XP/Win 7/Win 8 operating system 

  500MHz or faster microprocessor 

 A minimum of 128MB of RAM 

 CD drive  

Note: CD drive not required if installing from Zip file. 

 

 

 

Installing the 1800 Manager Application 

The 1800 Manager application is installed using a standard Windows installation utility. 

To install the application, 

1. Insert the installation CD into the CD-drive. 

2. If your system is configured to AutoPlay CDs, the installation utility should be 

launched automatically, and you may skip to step 5. 

3. Start the Windows Explorer and browse to the root folder of the 1800 Manager CD. 

4. Double-click on the file SETUP.EXE.  

5. The installation program will guide you through the subsequent steps. Simply follow 

the instructions as they appear on the screen.  

6. Select Finish when the installation process is completed. 

Chapter 
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Getting Started 

The user interface for 1800 Manager is similar to many other Windows programs.  

This chapter covers how to: 

 Start and exit the 1800 Manager application. 

 Work in the 1800 Manager window. 

Starting 1800 Manager 

To access the 1800 Manager utility,  

1. Open the programs menu of the PC with 1800 Manager installed. 

2. Open the Westronic folder. 

3. Click the 1800 Manager icon. The application will then open to the Upgrade (home) 

tab as shown in figure 3. 

   

Figure 1  – 1800  Manager – Program Location  

Chapter 
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4.  Exiting 1800 Manager 

To exit the application, you may choose File, and then Exit OR click on the close 

button in the upper-right hand corner of the main window. A confirmation dialog box 

appears. 

 

        Figure 2 – 1800  Manager – Exit Box 

 

5. Click the OK button to exit the application. 

 

Working in the 1800 Manager window 

 

Figure 3 – Connection (“Home”) tab shows when initially opened 
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The following list describes the parts of the1800 Manager window shown in Figure 3. 

 Title bar — The title bar contains the 1800 Manager icon (Westronic logo) along with 

the title of the application. Like all Windows screens, the minimize, maximize, and 

close buttons are located in the upper right-hand corner of the title bar. 

 Menu bar — The menu bar contains the File and Help drop-down menus. From the 

File menu, you can choose Load file, Save file, Import CSV, Export CSV, Display All 

Manager Disconnect Timeout and Exit items. The Help menu contains the About 

feature which displays the version of 1800 Manager and a link to the Westronic web 

page. These functions will be covered in Section 6 “Other Manager Features” of this 

manual 

 Edit box — A box in which you can type and edit text, dates, or numbers. 

 

Figure 4 -  Example of an Edit box 

 Tabs — Each Tab contains different options and parameters to be included in the 

RTU configuration. Some of these tabs may, or may not appear depending on the 

licensing of the WS1800 undergoing configuration. These tabs are: General, 

Upgrade, Communication, Discrete Inputs, Discrete Controls, Analog Inputs, Analog 

Alarm Points, T/H Readings, T/H Alarm, SNMP and Serial/Modem port. Many of the 

tabs contain radio buttons and menus to further functionality. These will be described 

in separate sections of this manual for each tab. You can switch amongst the tabs by 

clicking on the desired tab. 

 Check box — A square box that can be turned on (enabled) or off (disabled). The 

option linked to the check box is enabled when a  appears in the box.  

 Button — buttons are used to execute or cancel a command. With the left mouse 

button, you click on the button to execute the command.  

 Status bar — the status bar may appear at the bottom of the screen to show the 

progress of connection, upload or download status. 
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WS1800 Manager Tabs 

This section describes the function and use of the various tabs in the WS1800 Manager 

application.  

General Tab 

To create a new or change an existing RTU record, open the WS1800 Manager program. 

The standard default shipping settings for a typical WS 1800 will automatically populate 

upon opening. If you will be using a saved configuration (e.g. from another unit as a 

template) go to: File -> Load File -> (your file location and name) and then click Open 

before proceeding. See Chapter 6 for more details on this functionality.  

Then: 

1. Click on the General Tab. 

 

Figure 5 – The General Information Tab (default information shown) 

2. Begin by entering the IP of the unit you wish to connect to in the upper right hand 

corner of the tab. This portion of the GUI shows on all tabs. The Port shown is 

shipping default for the Manager connection; Port 24. It is assumed the IP selected 

has previously been directly entered into the WS1800 along with appropriate router 

and netmask information through the Craft Port on the unit. This can be done using 

Chapter 

4 



  WS1800 Manager —Function and Use of Manager Tabs 

994-T074 Rev A – July 2015  9 

any standard terminal emulation software. Please see Section 6 of the WS1800 

Technical Manual “Getting the WS1800 Up and Running” for more information.  

Important Note: This IP may be different to, or the same as the final IP that will be 

uploaded from the Communication tab in the WS1800 Manager application. For 

saved configurations that are being updated, the IP shown in the Communications tab 

will generally also be typed into the upper left corner of the screen to connect with the 

desired RTU.  

3. If required, System Name, SID, System Contact, System Location and Tech notes 

can all be changed via this tab.  

Note: The SID identifies the RTU and is the first parameter displayed in any 

autonomous TL-1 message. It is a maximum of 20 characters long, limited to letters, 

digits, and hyphens. The SID is case sensitive. In most cases, the SID is the RTU’s 

Common Language Location Identifier (CLLI). 

4. If desired, heartbeats can be enabled (or disabled) through the checkbox and the 

heartbeat interval (in minutes) can be set from this tab. Range is 1 to 65535 minutes. 

5. Continue entering System Contact, System Location and Last Tech Notes as desired. 

6. Click on the Edit Users button to enter or change user as desired. The user MTC is 

the default user for new units. Note: The MTC default cannot be deleted or changed 

until at least one new Level 5 user is created and saved. 

 

 

Figure 6 – TL1 user Tab 

7. Add or edit more users as desired in the TL1 Users pop up window. 

8. Click Close to close the TL1 Users pop-up window.  

9. The Flashing LED checkbox applies only to 32 point units as the WS1800 is equipped 

with 16 LED’s to indicate discrete alarm status. Flashing LEDs are used for points 17-

32 to give a technician onsite the ability to quickly differentiate between (for example) 

an alarm solely on discrete input 1 , solely on discrete input 17 (which shares same 

LED with input 1) or an alarm on both 1 and 17 at the same time. Unchecking this box 

puts all alarms in non-flashing LED mode. Please refer to the WS1800 technical 

manual for more information. 

10. Hit the Save button to save any changes in Manager for later uploading to the 1800, 

or to be saved to file.  

11. The Show License and Set RTU License buttons will be greyed out and inactive 

unless the Manager program is currently connected to a WS1800. The Show License 

button will open an additional sub-window that lists Enabled Features (black font) and 

Disabled Features (Red Font) for the WS1800 presently connected. It will also change 
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the availability and/or functionality of other tabs in Manager. The Set RTU License 

button allows entry of a new license key such as may be provided by Westronic 

Technical support.  

12. In Figure 7 below, the General Tab is now shown when connected to a WS1800. 

Note that the Show License and Set RTU License buttons have become active, and 

the Firmware Version of the unit connected to WS1800 Manager is shown above 

them for reference. In this case, the Show License button has been used, the License 

info of the WS1800 is showing on the right. Also note that the Show License has now 

become a Hide License button. 

 

 

Figure 7 – General Tab when Manager connected to an RTU 

 

13. If the Set RTU License button is used when WS1800 Manager is connected to a unit, 

the following window will appear. A valid WS1800 license key obtained from 

Westronic will be four capital letters followed by a hyphen, followed by four more 

capital letters. EG: XXXX-XXXX    Note: Only enter a valid license key that is obtained 

directly from Westronic Technical Support.    See Figure 8 below. 

 

Figure 8 – License Key entry dialog box 
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Connection Tab 

 

Figure 9  – Connection Tab when NOT connected to an RTU 

 

Connecting to the RTU 

1. Note that when the application is not connected to an RTU as shown above in Figure 

9, all buttons except the Connect button are inactive. (greyed out) 

2. Enter the IP and upgrade port of the WS1800 you wish to connect to in the upper left 

portion of the screen. For more information see the General Tab description under 

point 2.  

3. Click on the CONNECT button to establish a connection with the specified RTU. Once 

the RTU has been contacted, a Login window will appear, see Figure 10 below. Enter 

the appropriate Username and Password to log in. A different box may appear when 

connecting to a WS1800 with older firmware not having the same level of user 

verification. See Figure 11 on next page. 

 

     Figure 10  – Login Box for WS1800 
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        Figure 11  – Older Firmware, No User Verification box 

 

4. If an incorrect IP and/or port have been entered, the following Dialog box will appear: 

 

 

Figure 12 – Connection Not Successful dialog box 

 

 

5. Should an incorrect Username and/or Password have been entered into the Login 

box, the following Dialog box will appear: 

 

         Figure 13 – Connection Error dialog box 

6. Once the Username and Password have been verified, an information dialog box 

appears indicating the status of your login.  Click OK to close the Information dialog 

box. 

         

Figure 14 – Successful Connection dialog box 

7. The Connect button now changes status to a Disconnect button and the Get 

Database and Send Database buttons will become active (no longer greyed-out). 
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8. Click OK to close the Information dialog box. 

9. Figure 15 below shows the buttons that become activated when you have connected 

to the RTU and the information displayed in the status bar at the bottom of the dialog 

box. This instance of Manager is connected to the default upgrade port (24), so the 

Get Database (view what is on the RTU) and Send Database (change what is on the 

RTU) buttons are active. The Send File Abort and Reboot buttons are greyed out as 

they cannot be used on this port. Their use will be covered in the Firmware Upgrading 

section of this manual in Chapter 5. 

Important Note: At this point, the information displayed within the various Manager 

Tabs does not necessarily reflect what is currently configured on the RTU.  

 

 

Figure 15  –Upgrade Tab when connected to active WS1800 

 

Get Database,  from the RTU 

1. Once logged in, the Get Database button will upload the current configuration from the 

RTU and overwrite the current configuration onscreen in Manager.  

Important Note: Be sure you are overwriting a default or scrap configuration before 

proceeding so that no unsaved RTU configurations are lost!   

 

2. Once the configuration has been successfully uploaded the following dialog box will 

appear. Click OK. Now the information populated in the various tabs of Manager 

reflects the configuration currently on the RTU. 



  WS1800 Manager —Function and Use of Manager Tabs 

994-T074 Rev A – July 2015  15 

 

Figure 16 – Configuration successfully uploaded 

3. The RTU continues to actively report alarms through this process. A configuration can 

be modified in Manager while still online with the RTU, or offline by clicking the 

Disconnect button. Generally, it is preferable to work offline unless the configuration 

changes are quick and relatively simple. 

4. If needed, save the current database to file under an appropriate name.  

 

Send Database, to the RTU 

1. Once logged in, the Send Database button will enable downloading of the current 

configuration onscreen in Manager and overwriting of the existing configuration in the 

RTU. The RTU will continue to collect alarms during the Send Database process. It 

will however briefly go offline while the database is being written into FLASH and the 

unit reboots.  

Important Note:   Be sure to verify the unit IP and Manager IP Port on the 

Communications Tab prior to performing a Send Database. The IP in the upper 

left of the Manager screen is the IP connected to the RTU currently; the IP on the 

Communications Tab is the IP it will restart with after the Send Database has 

occurred. If the IP has been changed, a warning will appear as shown in step 6 prior 

to the actual database send. 

2. Following verification of IP and port, click on the Send Database button. This will send 

all aspects of the configuration presently loaded on the various Manager tabs to the 

RTU. The following dialog box will open to confirm you wish to proceed: 

 

Figure 17 – Confirm Send Database 

3. A progress bar for the data transfer will appear within the lower portion of the Manager 

screen, and after a few seconds the following verification box will appear. Click OK to 

continue, or Cancel to abort the database changes to the RTU: 

 

Figure 18  – Confirm Database write 
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4. The RTU will now be offline for a few seconds during the write and reboot process. 

The following information box will appear in Manager, click OK to close this box: 

 

Figure 19  – Database Write and reboot information box 

5. If not already done, save the current onscreen Manager database to file under an 

appropriate name.  

6. If the IP has been changed in the configuration to make it different than the IP 

currently connected with, this information box will appear warning of the pending IP 

change:  

 

Figure 20  – Change of IP warning box 

 

7. Click Yes to proceed with the download including IP change, or No if the impending IP 

change was not desired. The IP can be changed and the configuration resent if 

required. 

 

 

 

 

Disconnecting from the RTU 

1. When a Get Database is completed, you can disconnect from the RTU by clicking the 

Disconnect button.  

2. Manager will automatically disconnect from the RTU once the Send Database 

process is completed. 

3. In both cases, when disconnect is completed, the Disconnect button with turn into a 

Connect button and all others on this tab will be greyed out. 
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Connection Timeout 

If enabled, WS1800 Manager will automatically disconnect from the unit following a 

configurable period of inactivity. This prevents the unit from being inadvertently ‘tied’ to an 

instance of Manager should a user forget to close Manager or disconnect from a unit 

undergoing configuration. Although the default behavior of Manager is with this feature 

Disabled, it is strongly recommended that it be Enabled. (default time when enabled is 30 

minutes) See section 6 of this manual for further information. Below is a screenshot of the 

configuration window: 

 

 

 

 

 Figure 21 – Manager Disconnect Timeout, see File menu dropdown
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TCP/IP Settings Tab 

The TCP/IP Settings Tab allows making changes to IP connectivity parameters of the 

RTU. See figure below for a screenshot of this tab. Note: This tab appears the same 

whether offline or actively online with a WS1800. 

 

Figure 22  – The Communications tab 

1. IP Connection ACL (Active Control List) This is a list of ‘friendly’ IP’s which are 

allowed to communicate with the RTU. Default setting for all 8 IP’s is 0.0.0.0 which is 

effectively ACL-Disabled. Double click on any IP shown, a dialog box will open 

allowing a new IP to be entered, with Save and Cancel options. Either will close the 

dialog box. 

 

Figure 23  – The Communications tab 

IMPORTANT Note: By enabling any ACL- IP, all others are actively excluded. Care 

should be taken to enable more than one IP, and that these IP’s are correct when 

uploaded. Should a single-incorrect IP be uploaded, the only option for reconnection 

is by command line interface directly at the unit’s serial port. 
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2. Manager Port. Default is 24. This can be changed to any port 1 to 65535 but cannot 

be changed to the same port as Telnet (23) or the TABS-IP port (where applicable). 

3. IP, Router and Netmask. The parameters on this tab are the network parameters the 

RTU will resume operating with after performing a Send Database. Note: This IP may 

not be the same as the IP used for initial connection to the RTU. If you do not want to 

change the IP of the RTU, be sure this IP and the one in the upper left connection box 

are the same.  

NOTE: Manager will provide a warning prior to uploading a configuration with an IP 

different to the one presently connected with.  

4. TABS Over IP reporting. For units with TABS-IP license, allows configuration of TABS 

address and display, TCP port and host timeout. If the WS1800 is not licensed for 

TABS the Tabs Over IP Reporting button will be inactive. It will also be inactive if the 

unit is licensed for TABS and serial port B was previously activated for serial TABS-R. 

 

Figure 24  – TABS Over IP Configuration box 

5. The following parameters can be changed on this menu: (they will not be available 

unless the unit is licensed for TABS and Ethernet) 

a) Port – TCP port carrying TABS-IP. Default is 0 (TABS-IP reporting disabled) up 

to 65535. Enter a port number other than reserved ports 23, 24, 80, 161 & 162. 

b) Host Timeout – Default is 120 seconds. If connectivity is lost, a shorter timeout 

will put a point 64 fail alarm sooner, busy networks should consider a longer 

timeout. Range is 1 to 65535 seconds.  

c) Address – Starts with TABS address 0 (default) up to 31.  

d) Start Display – Unit starts displaying the TABS information of the following 

address. Default is Display 0 with range up to display 255. 

e) No. of Displays –Controls the number of TABS displays carrying information.  

Default is 2, option is 1 display. All Discrete points are presented in the first 

(lowest) display. The 2
nd

 Display is required should the unit be equipped with an 

analog or MPBM option and this information is to be presented in TABS. The third 

display is required to present Temperature and/or Humidity alarm information via 

TABS. 
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6. Use Save to keep any changes made, Cancel to discard them back to defaults or 

previous settings as may apply. 

7. If changes are made to any items on this tab, save to file on the PC and/or Send to 

the RTU as appropriate. 
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Discrete Inputs Tab 

The Discrete Inputs Tab allows making changes to a variety of discrete input parameters 

as outlined below. Figure 24 shows a screenshot of this tab.  Note: This tab appears the 

same whether offline or actively online with a WS1800. 

 

Figure 25  – The Discrete Inputs tab 

1. The default configuration for this tab is 32 points as shown here. If a Get Database is 

done from any unit licensed for 16 points, only the first 16 points will show on this list. 

In all other cases 32 points will be shown. 

2. Each point can be individually edited by double clicking on it. The following menu will 

open: 

 

Figure 26 – The Edit Discrete Inputs sub menu 
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3. The Edit Discrete Inputs sub menu box offers the following options for each discrete 

point: 

a) Report Enable - Yes (default) or No. Disabled points will turn red in the far left 

column as a quick visual indicator. 

b) AID - (Access Identifier), eg default for discrete point 1 is DISCRETE-1-1. The 1-1 

numbering is derived from these points showing in the first TABS or TBOS 

display configured (where enabled by license) starting with point 1. Subsequent 

discrete points are similarly named in ascending order (eg 1-2, 1-3 etc). The AID 

can changed but this is not recommended, limit is 20 characters. 

c) Description -  Description of each point. Example of default for point 1 is “ 

Discrete Point 01”. Can up used as text field up to 32 characters. 

d) Severity -  Dropdown menu with CR, MJ, MN, RN (default), CL and NA options. 

e) Effect - Dropdown menu with NSA (default) and SA options. 

f) Location -  Text field up to 10 characters. Default is blank.  

g) Alarm State - Dropdown menu with Closed (default) and Open options. Closed 

means no grounding of that discrete input causes No Alarm. Open means 

continuous grounding is required to cause a No Alarm condition. Open is also 

known as an ‘inverted point’.  

h) SID -  Source Identifier, text field up to 20 characters. Default is blank. 

i) Workgroup -  Default is EN, can be text up to 3 characters 

j) AID Type - Dropdown menu with five choices: EQPT (default), T1, T3, OCT and 

LINK. 

k) Modem - For units licensed for and equipped with a dial-up modem, allows option 

of any point reporting to none, one or both configured dial out numbers. 

l) Condition Type - Default is “GP”. Can be text string up to 10 characters. 

 

4. Make changes within this box for each point individually, clicking Save in the box to 

close it. 

5. Once all the necessary points are edited as required on this tab, save to file on the PC 

and/or Send to the RTU as appropriate. 
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Discrete Controls Tab 

The Discrete Controls Tab allows making changes to a variety of discrete control 

parameters as outlined below. Figure 27 shows a screenshot of this tab.  Note: This tab 

appears the same whether offline or actively online with a WS1800. 

 

Figure 27  – The Discrete Controls tab 

6. The default configuration for this tab is 4 controls as shown here. If a Get Database is 

done from any unit licensed for 16 points, only the first 2 controls will show on this list. 

In all other cases 4 controls will be shown. 

7. Each control can be individually edited by double clicking on it. The following menu 

will open: 

 

Figure 28 – The Edit Discrete Controls sub menu  

 



WS1800 Manager — Function  and Use of Manager Tabs 

24  994-T074 Rev A  –  July 2015 

. 

8. The Edit Discrete Controls sub menu box offers the following options for each discrete 

point: 

a) Report Enable - Yes (default) or No. Disabled points will turn red in the far left 

column as a quick visual indicator. 

b) Control # - Number of control currently being edited. Text cannot be changed. 

c) Description - Description of each point. Example of default for Control 2 is 

“Control Point 02 not configured”. Can up used as text field up to 32 characters. 

d) Duration – When a “Momentary” command is sent to a control, this parameter 

defines how long it should close. Duration range 400 – 999 Milliseconds. 

9. Make changes within this box for each Control individually, clicking Save in the box to 

close it. 

10. Once all the necessary Controls are edited as required on this tab, save to file on the 

PC and/or Send to the RTU as appropriate. 
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Analog Inputs Tab 

The Analog Inputs Tab allows making changes to a variety of analog input parameters as 

outlined below. Figure 29 shows a screenshot of this tab.  Note: This tab appears the 

same whether offline or actively online with a WS1800. 

 

Figure 29  – The Analog Inputs tab 

1. If the unit connected to or the file presently loaded in Manager is NOT licensed for 

either an MPBM (Mid-Point Battery Monitor) or Analog accessory board, this tab will 

not appear as part of the Manager menu. 

Note:  This menu always appears as part of the default configuration when Manager 

is first opened, or when connected to or using a configuration from a unit licensed for 

MPBM or Analog. Different default values may appear in some parameters depending 

upon whether the unit is licensed for MPBM or Analog use. 

Note:   Analog Channels 7 and 8 have dual functionality which is dependent on the 

setting of physical jumpers on the Analog board;  0-60 volts or -100 to 100 mV. 

Consult the WS1800 Technical Manual for more details. Several configuration 

parameter changes within Manager are required to match the -100 to100mV settings 

of ports 7 and 8, these are noted below. 

2. When applicable to appear, the default configuration for this tab is 8 analog points is 

typically as shown above. 
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3. Each point can be individually edited by double clicking on it. The following menu will 

open: 

 

Figure 30  – The Edit Analog Inputs sub menu   

4. The Edit Analog Inputs sub menu box offers the following options for each discrete 

point: 

a) AID - (Access Identifier), eg default for Analog point 2 is ANA02. Can changed 

but this is not recommended, limit is 20 characters. 

b) Description - Description of each point. Example of default for point 2 is “Analog 

#2”. Can up used as text field up to 32 characters. 

c) Location -  Text field up to 10 characters. Default is NEAR. 

d) Range Start – Default is 0.0 volts for MPBM and Analog.  When channels 7 and 

8 are put in 100 mV mode, this should be set to -100.0 mV. 

e) Range End – Default is 60.0 volts, the maximum setting for this parameter. This 

value must be set prior to setting LOLO, LO, HI and HIHI for Manager’s error 

checking to work correctly. Error checking will not allow this setting to be lower 

than HI or HIHI setting.  For analog boards with Ch 7 and 8 physically set to mV 

mode, this parameter should have a maximum setting of 100mV. 
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f) Units – Default is Volts but can be text string describing any units up to a limit of 

32 characters.  

g) Threshold LOLO – Must be above Range start value and Lower than LO, HI, 

HIHI and Range End. Default is 48.0 volts for most cases. Should be at or above 

-100 mV for channels 7 and 8 on analog boards physically set to mV mode. 

h) Threshold LO - Must be above Range start value and LOLO value, and lower 

than HI, HIHI and Range End. Default is 50.0 volts in most cases. This should be 

a value between -100 and plus 100 mV for Analog channel 7 and 8 when boards 

are physically set to mV mode. 

i) Threshold Hi - Must be above Range start , LOLO and LO values, but lower than 

HIHI and Range End. Default is 54.0 volts in most cases.  This should be set to a 

value between 0 and 100 mV for Analog channel 7 and 8 when boards are 

physically set to mV mode. 

j) Threshold HiHi - Must be above all values except for Range End. Default is 60.0 

volts in most cases. For Analog boards with Ch 7 and 8 configured to mV mode 

this should be a value of or near to 100 mV. 

k) Deadband -  The deadband value is used to keep a point from being 

inadvertently reported as a change of state when the input amount only changes 

slightly. A change of state will only be reported when the parameter value has 

exceeded the threshold by an amount greater than the deadband.. Default value 

is 0.2 volts in most cases, A value of 0.6 mV is suggested for Ch 7 and 8 when 

they are on an Analog board configured to 100 mV. 

l) SID - Source Identifier, text field up to 20 characters. Default is blank. 

m) AID Type - Dropdown menu with five choices: EQPT (default), T1, T3, OCT and 

LINK. 

n) Condition Type - Default is Type. Can be text string up to 10 characters. 

o) Workgroup - Default is EN. Can be text string up to 3 characters 

 

5. Make changes within this box for each point individually as required, clicking Save in 

the box to close it. 

6. Once all the necessary points are edited as required on this tab, save to file on the PC 

and/or Send to the RTU as appropriate. 
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Analog Alarm Points Tab 

The Analog Alarm Points Tab allows making changes to a variety of analog alarm point 

parameters as outlined below. Figure 31 shows a screenshot of this tab.  Note: This tab 

appears the same whether offline or actively online with a WS1800. 

 

Figure 31  – The Analog Alarm Points tab 

1. If the unit connected to (or the file presently loaded in) Manager is NOT licensed for 

either an MPBM (Mid-Point Battery Monitor) or Analog accessory board, this tab will 

not appear as part of the Manager menu. 

2. When applicable to appear, the default configuration for this tab has the 33 analog 

alarm points is typically as shown above. Note that the first point is used to indicate a 

failure of the module itself, with all other points following in order such as they were 

configured in the Analog Inputs tab. 
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3. Each point can be individually edited by double clicking on it. The following menu will 

open: 

 

Figure 32  – The Edit Analog Alarm sub menu   

4. The Edit Analog Alarm sub-menu box offers the following options for each Analog 

point:. 

a) Report Enable - Yes (default) or No. Disabled points will turn red in the far left 

column as a quick visual indicator. 

b) AID - (Access Identifier), e.g. Default for analog point 1 is ANAALARM_2_1. The 

2_1 numbering is derived from these points showing in the 2
nd

 TABS or TBOS 

display configured (where enabled by license) starting with point 1. Additional 

analog points, where enabled, are similarly named in ascending order (eg 2_2, 

2_3 etc). The AID can changed but this is not recommended, limit is 20 

characters. 

c) Description -  Description of each analog alarming point. Example of default for 

analog point1 is “Analog Module Failure” to describe a failure of loss of 

communication with the analog module. Subsequent points are named on the 

LOLO, LO, HI and HIHI basis parallel to those configured under the Analog Inputs 

menu. Can up used as text field up to 32 characters. 

d) Severity -  Dropdown menu with CR, MJ, MN, RN (default), CL and NA options. 

e) Effect - Dropdown menu with NSA (default) and SA options. 

f) Location -  Text field up to 10 characters. Default is NEAR.  

g) SID -  Source Identifier, text field up to 20 characters. Default is blank. 
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h) Workgroup -  Default is EN, can be text up to 3 characters 

i) AID Type - Dropdown menu with five choices: EQPT (default), T1, T3, OCT and 

LINK. 

j) Modem - On units licensed for and equipped with a dial-up modem, allows option 

of any point reporting to none, one or both of the configured dial out numbers. 

5. Make changes within this dropdown box for each point individually as required, 

clicking Save in the box to close it. 

6. Once all the necessary points are edited as required on this tab, save to file on the PC 

and/or Send to the RTU as appropriate. 
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Temperature/Humidity Readings Tab 

The Temperature/Humidity Readings Tab allows making to a variety of temperature and 

humidity input parameters as outlined below. Figure 33 shows a screenshot of this tab.  

Note: This tab appears the same whether offline or actively online with a WS1800. 

 

Figure 33  – The Temperature/Humidity Readings tab 

1. This tab always appears as part of the default configuration when Manager is first 

opened. No part of this tab is license dependent; i.e. it will look the same for all 

variants of WS1800.  

NOTE: Only the first parameter, TEMP-01, is used for most WS1800. This parameter 

is for the native temperature sensor which is built onto every WS1800 main board. 

 The other temperature and all humidity parameters (TEMP-02 and -03, HUMI-01 and 

-02) only become active when the WS1800 has a pn# 585-1803 sensor interface kit 

installed and is connected to one (or two) pn# 542-T010 temperature/humidity pods. 

No additional licensing is required to enable monitoring the pods and most versions of 

firmware will auto-detect the pods when they are connected. 
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2. When an environmental parameter is double clicked on, the following menu will open. 

Here the example is the onboard temperature sensor, TEMP-01, that is part of each 

WS1800 unit: 

 

Figure 34 – The Edit Environment sub menu, TEMP-01 shown 

3. The Edit Environment sub menu box offers the following options for each environment 

point, with differences as noted for default values between temperature or humidity 

points: 

a) AID - (Access Identifier), Default for native temperature is TEMP-01, with TEMP-

02 and TEMP-03 for optional pods. Humidity points for optional pods are HUMI-

01 and HUMI-02. The AID can changed but this is not recommended, limit is 20 

characters. 

b) Units – Default for temperature is DegreeCelcius and for humidty is %RH, but 

can be text string describing any units up to a limit of 32 characters.  

Note: It is preferable to use DegC for temperature readings  as the error checking 

within the GUI is designed around Celsius values.  

Note: If not using defaults, enter the LOLO value first, followed by HIHI value. 

Error checking can then verify LO and HI values automatically. 
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c) Location -  Text field up to 10 characters. Default is NEAR for all environment 

parameters. 

d) Threshold LOLO – Must be lower than LO, HI, HIHI for any parameter. 

Temperature LOLO default is -10.0 DegC with a limit of -40.0 DegC. Humidity 

default is 5% RH with a limit of 0%RH. This should always be the first value 

entered in each Temp/Hum window. 

e) Threshold LO - Must be above LOLO value, and lower than HI and HIHI for that 

parameter. Default is 0.0 DegC for temperature parameters and 10%RH for 

humidity parameters.  

f) Threshold Hi - Must be above LOLO and LO values, but lower than HIHI for that 

parameter. Default value is 50.0 DegC for temperature parameters and 90%RH 

for humidity parameters.  

g) Threshold HiHi - Must be above all other values within that parameter. Default 

value is 60.0 DegC for temperature parameters and 95%RH for humidity 

parameters. Limit is 123.0 for temperature parameters and 100%RH for humidity 

parameters. This should be the second parameter entered in each Temp/Hum 

window. 

Note:  The maximum value of 123.0 is inappropriate for Celsius temperatures but 

is allowed within the GUI logic to facilitate alarming should Fahrenheit 

temperature be preferred. 

h) Deadband -  The deadband value is used to keep an temperature or humidity 

point from being inadvertently reported as a change of state when the input 

changes slightly. A change of state will only be reported when the parameter 

value has exceeded the threshold by an amount greater than the deadband.  

Default deadband range is 0.1 to 10 degrees for temperature and 0.1 to 

10.0%RH for humidity. 

i) Description - Description of each environment point. Example of default for the 

onboard temperature sensor  is “TEMPERATURE VALUE”. Can up used as text 

field up to 32 characters. 

j) Workgroup -  Default is EN, can be text up to 3 characters. 

4. Make changes within this box for each point individually as required, clicking Save in 

the box to close it. 

5. Once all the necessary points are edited as required on this tab, save to file on the PC 

and/or Send to the RTU as appropriate. 
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Temperature/Humidity Alarm Points Tab 

The Temperature/Humidity Alarm Points Tab allows configuration of the environmental 

alarm point parameters as outlined below. The figure below shows a screenshot of this 

tab.  Note: This tab appears the same whether offline or actively online with a WS1800. 

 

Figure 35  – TheTemperature/Humidity Alarm Points tab 

1. Each point can be individually edited by double clicking on it. The following menu will 

open: 

 

Figure 36  – The Edit T/H Alarm sub menu 

 

2. The Edit Analog Alarm sub-menu box offers the following options for each Analog 

point:. 
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a) Report Enable - Yes (default) or No. Disabled points will turn red in the far left 

column as a quick visual indicator. 

b) AID - (Access Identifier), e.g. Default for the LOLO point of the onboard 

temperature sensor is T_H_ALARM_3_1. The 3_1 numbering is derived from 

these points showing up in the 3
rd
 TABS or TBOS display (where enabled by 

license) starting with point 1. Humidity and additional temperature points, where 

enabled, are similarly named in ascending order (eg 3_9, 3_10 etc). The AID can 

changed but this is not recommended, limit is 20 characters. 

c) Severity -  Dropdown menu with CR, MJ, MN, RN (default), CL and NA options 

d) Effect - Dropdown menu with NSA (default) and SA options. 

e) Description - Description of each environmental alarming point. Example of 

default of LOLO for the native temperature sensor is “Temperature #01 LOLO”. 

Subsequent points are named on the LO, HI and HIHI basis parallel to those 

previously configured under the Environmental Inputs menu. Can up used as text 

field up to 32 characters. 

f) SID - Source Identifier, text field up to 20 characters. Default is blank. 

g) AID Type - Dropdown menu with five choices: EQPT (default), T1, T3, OCT and 

LINK. 

h) Type - Text field up to 10 characters. Default is blank. 

i) Location - Text field up to 10 characters. Default is NEAR. 

j) Workgroup -  Default is EN, can be text up to 3 characters 

k) Modem - For units licensed for and equipped with a dial-up modem, allows option 

of any point reporting to none, one or both of the configured dial out numbers. 

Note:  For a standard WS1800 (i.e. without optional Temp/Humidty sensors) only the 

first four Temperature alarm points will be used. These are for the built-in temperature 

sensor that is installed on every WS1800 main board. Changing the other parameters 

will have no effect. 

3. Make changes within this dropdown box for each point individually as required, 

clicking Save in the box to close it. 

4. Once all the necessary points are edited as required on this tab, save to file on the PC 

and/or Send to the RTU as appropriate. 
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The SNMP Tab 

The SNMP Host Configuration Tab allows enabling the WS1800 (where licensed) to 

report to up to five hosts. Below is a screenshot of this tab.  Note: This tab does not 

appear when connected to or using a configuration from a WS1800 that is not licensed for 

SNMP. 

 

Figure 37  – The SNMP Host Configuration tab 

1. This tab typically appears as part of the default configuration when Manager is first 

opened, or will appear when connected to a WS1800 which is licensed for SNMP.  
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2. When one of the SNMP host lines is clicked on in the SNMP tab, the following menu 

will open. Here the example is SNMP Host #1: 

 

Figure 38 – The Edit SNMP sub menu, Host #1 shown 

3. The Edit SNMP Host sub menu box offers the following options for each SNMP host: 

a) IPAddress – Can be any IP address on the network valid for the SNMP 

manager. 

b) TCPPort – Default is port 162 but can be any value between 1 and 65535 that is 

allowed by the collecting SNMP management system. 

c) TrapReporting – Dropdown menu with two choices, Disabled (default) and 

Enabled. 

d) Community – Default is “public” but can be used as text field up to 32 characters.  

4. Make changes within this dropdown box for each point individually as required, 

clicking Save in the box to close it. 

5. Once all the necessary points are edited as required on this tab, save to file on the PC 

and/or Send to the RTU as appropriate. 
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The Serial/Modem Port Tab 

The Serial/Modem Port Configuration Tab allows enabling the WS1800 (where licensed) 

to report in TABS or TBOS, dial out through a dial up modem, or act as a terminal server 

through up to four other serial ports (when equipped) . Below is a screenshot of the default 

tab when Manager is first opened.  Note: Portions of this tab will appear differently in 

specific sub-menus depending on the license key of the WS1800 under configuration.  

 

Figure 39  – The Serial/Modem Port Configuration tab 

1. This tab facilitates configuration of the various serial ports on a WS1800 including 

enabling and/or disabling many features associated with these ports. Parts of this tab 

are license dependent; i.e. it will look the different for some variants of WS1800.  

NOTE: The checkbox “Expansion Serial Board Installed” should only be checked for 

units equipped with this option. It opens an additional area of the Serial tab to allow 

configuration of serial ports C through F. Any changes made will only take effect on 

units having this board. Presence of this board can be verified by physical inspection 

of the unit, or by contacting Westronic Technical Support with the part number and/or 

serial number of the WS1800 in question. 
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2. When one of the Serial port lines is clicked on in the Serial/Modem Port tab, the 

following menu will open. Here the example is Serial Port B, the RJ-11 port which is 

part of all WS1800 units: 

 

Figure 40  – Port B Dialup Modem settings with Dialup license 

3. If the unit is licensed for and equipped with a dialup modem, the above menu will be 

available with the following items which can be configured. If it does not have a dialup 

license, this menu will not appear and Dialup Modem parameters will look like figure 

41 which appears later in this document. 

a) Dialout Number 1 – This is the primary number that will be dialed when an 

alarm change of state or heartbeat interval takes place. Valid only when unit 

has Dialup Modem license and is equipped with a modem. A maximum of 32 

digits with no spaces. 

b) Dialout Number 2 – Should it be required for the unit to report to a 

secondary system, this is the additional number that will be dialed when a 

change of state or heartbeat interval occurs. Valid only when unit has Dialup 

Modem license and is equipped with a modem. A maximum of 32 digits with 

no spaces. 

Note:  All alarm points are individually configurable to use or not use this 2
nd

 

number. This setting is found within each alarm point in the various alarm 

menus.   

c) Connect Wait – Time in seconds unit will wait for connection to establish 

before disconnecting and counting down to next retry. Default is 40 seconds, 

available range is 1 to 65535 seconds. 
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d) Maximum Retries – Number of times unit will retry dialing each number after 

a failed connection. Default is 3, available range is 0 to 30 retries.  

e) Retry Interval – Time in seconds the unit will wait after a failed connection 

before next retry. Default is 20 seconds, available range is 1 to 65535 

seconds. 

f) Inactivity Time – Time in minutes the unit will remain connected after all 

alarm data has been passed through to the host with no new activity. Default 

is 5 minutes; available range is 1 to 360 minutes. 
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4. Figure 41 below shows the Port B, Dialup Modem dropdown option when unit does 

NOT have dialup license (default).  This option for port B is to be used with CDMA, 

LTE and HSPA modem connectivity for units so equipped. For units without one of 

these modems, choosing this option will render the RJ-11 MDM/Serial port of the 

WS1800 inactive. 

 

 

Figure 41  – Port B Dialup option selected without Dialup license 

5. When the Dialup Modem dropdown option is chosen for port B without the unit being 

licensed for a Dialup modem, the menu appears different than before and offers the 

following configurable parameters: 

a) Inactivity Timeout – This is feature is currently disabled for wireless modem use 

and has no effect on unit operation. Leave at default setting. 

b) TCP Port – This is the TCP port that the modem connects to its network with.   

c) Re-init Timeout – Should the connection between the WS1800 and the wireless 

modem fail or become corrupted, this is the amount of time in minutes that the 

WS1800 will wait prior to starting an re-initialization process to the wireless 

modem. Available range is 1 – 65535 minutes, default is 10 minutes. 
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6. Serial Port B, Serial Passthrough dropdown option and sub menu:  

 

Figure 42 – Port B with Serial Passthrough option chosen  

7. Serial port B, shown with Serial Passthrough option chosen. This option is available 

on all WS1800 regardless of license key but cannot be used for those units equipped 

with a dialout or wireless modem.  

NOTE: The RS232 (default) or RS485 configuration of this port is mechanical in 

nature and requires physical changes to settings inside the WS1800. Consult the 

WS1800 Technical Manual for details. This note applies to port B when it is used for 

Serial Passthrough, Serial TABS-R and Serial TBOS reporting. 

a) Baud Rate - Options in dropdown menu from 1200 to 57600 available. 19200 is 

the default setting 

b) Stop Bits -  The dropdown menu offers 1 bit (default) and 2 bit options. 

c) Data Bits -  The dropdown menu offers 8 bit (default) and 7 bit options. 

d) Flow Control – The dropdown menu offers No Flow Control (default) and 

Hardware Flow Control options.  

e) Parity – Default setting is No Parity, with Even and Odd options available in the 

dropdown menu. 

f) TCP Port -    The default is 52 for passthrough operation on serial port B. Any 

TCP port up to 65535 can be chosen with the exception of 23, 24 80, 161, 162 

and (if used) the TCP port for TABS-IP. If using the serial expansion board, then 

the four TCP ports chosen for their operation would also be exceptions. 
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8. Serial Port B, Serial TBOS reporting option and menu.  

 

Figure 43  – Port B with Serial TBOS option chosen 

9. Serial port B shown with Serial TBOS option chosen.  

Note:  This option is license key dependent for activation. If Serial TBOS is chosen for 

this port without the appropriate license key, Serial Port B will become inactive. 

The typical port settings for this protocol are listed below and may require entry into 

Manager prior to uploading the configuration to the WS1800. These settings will 

match the serial collection defaults of the Westronic WS3500. 

a) Baud Rate – Data rate for this protocol is 2400 Baud. 

b) Stop Bits – This protocol typically uses 2 stop bits. 

c) Data Bit – Setting for this protocol is 8 Data bits. 

d) Flow Control – No Flow Control is the normal setting for this protocol. 

e) Parity – Setting for TBOS is Odd Parity. 

f) Start Display Number – This can be set from TBOS Display 0 (Default) to 7.  
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10. Port B, Serial TABS Reporting option Selected. This menu option will not appear if the 

unit is not licensed for TABS. 

 

Figure 44  – Port B with Serial TABSR option chosen 

11. Serial port B shown with Serial TABSR Reporting option enabled. This option is 

license key dependent for activation. 

Note: TABS-R via serial port B and TABS-IP cannot be used at the same time. If the 

TABS-IP TCP port is set to 0 (disabled), TABS-R will be allowed; if the TABS-IP TCP 

port is set to any other value TABS-R will not be allowed. If this is attempted, the 

following warning will appear: 

 

 

Figure 45  – TABS-IP conflict meassage 

 

The typical port settings for this protocol are listed below and may require entry into 

Manager prior to uploading the configuration to the WS1800. These settings will 

match the TABS-R serial collection defaults of the Westronic WS3500. 
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a) Baud Rate - Default data rate for this protocol is 2400 Baud. 

b) Stop Bits - Default for this protocol is 1 stop bit. 

c) Data Bits - Default setting for this protocol is 8 Data bits. 

d) Flow Control – No Flow Control is the normal default for this protocol. 

e) Parity – The default setting for TABS is Odd Parity. 

f) TABS Address – Select a TABS address from 0 (default) to 31. 

g) Start Display Number – Select a TABS Display from 0 (default) through 255. 

h) Number of Displays -   Select how many TABS Displays are used by the unit. 

Valid entries are 1 and 2. Having just 1 display will only show discrete inputs via 

TABS, 2 displays are required to show all Analog points as well (if licensed and 

so equipped).  

 

 

12. For units equipped with the additional serial expansion option, configuration of serial 

ports C to F may be required. Note: Ports C,D,E and F all have the same 

configuration parameters available. The ability to access this menu is facilitated by 

clicking the “Expansion Serial Board Installed” checkbox. Once that has been done 

the default configuration of Manager is with ports C through F disabled as shown 

immediately below.  

 

Figure 46  – Edit serial ports C through F, Port C - Disabled shown 

 

13. Now port C is shown in one of its two options, Serial Passthrough mode. Default TCP 

port setting is shown. If changing this port number, ensure it is not the same as the 

Manager, Telnet or other passthrough ports. 



WS1800 Manager — Function  and Use of Manager Tabs 

46  994-T074 Rev A  –  July 2015 

 

Figure 47  –Port C shown in Serial Passthrough mode 

 

14. This is the other option available for ports C through F; Modem Passthrough. Default 

TCP port setting is shown. If changing this port number, ensure it is not the same as 

the Manager, Telnet or other passthrough ports. 

 

Figure 48  –Port C shown in Modem Passthrough mode 

 

15. The following parameters for ports C through F can be configured as outlined below 

for either Serial Passthrough or Modem Passthrough options. Standard defaults 

offered by the GUI reflect normal settings for these ports in both cases. Continue 

through the menu to configure (or leaved disabled) ports D through F in the tab as 

required.  
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NOTE:  RS232 (default) or RS485 configuration of these ports is mechanical in nature 

and requires physical changes to settings inside the WS1800. Consult the WS1800 

Technical Manual for details. The speed of ports C through F should be limited to 

9600 Baud if all 5 ports are being used in Serial Passthrough mode. 

a) Baud Rate – Options in dropdown menu from 1200 to 57600 available. 9600 is 

the default setting. 

b) Stop Bits – Dropdown menu offers 1 bit (default) and 2 bit options. 

c) Data Bits - Dropdown menu offers 8 bit (default) and 7 bit options. 

d) Flow Control - Dropdown menu offers No Flow Control (default) and Hardware 

Flow Control options. 

e) Parity – Menu offers No Parity (default), Odd and Even options. 

f) TCP Port – Ports C through F automatically default to TCP port 53 through 56 

respectively for both Serial and Modem passthrough options. These can be 

changed but care must be taken not to duplicate Telnet, Upgrade and TABS-IP 

port numbers. 

16. Make changes within this dropdown box for each point individually as required, 

clicking Save in the box to close it. 

17. Once all the necessary points are edited as required on this tab, save to file on the PC 

and/or Send to the RTU as appropriate. 

 

 

 

 

 

 

 

 

 

 

 

 

 



WS1800 Manager — Function  and Use of Manager Tabs 

48  994-T074 Rev A  –  July 2015 

 

This page was intentionally left blank 

 

 

 

 

 

 

 

 

 

 

 



  WS1800  Manager — Function and Use of Manager Tabs 

 

994-T074 Rev A – July 2015  49 

 

This page was intentionally left blank 



WS1800 Manager — Function  and Use of Manager Tabs 

50  994-T074 Rev A  –  July 2015 

This page was intentionally left blank 



WS1800 Manager — Remote Firmware Upgrading 

994-T074 Rev A – July 2015  51 

 

Upgrading WS1800 Firmware Through Manager 

 

This section describes upgrading WS1800 firmware remotely through Manager. 

IMPORTANT NOTE: When using 1800 Manager the configuration must be uploaded from 

the RTU and saved to file prior to making changes and downloading new firmware.  This will 

ensure that the current RTU configuration is present in 1800 Manager along with a backup.  

Failure to do this may result in the loss of all configuration information for an RTU. 

 

IMPORTANT NOTE: At times of high network activity, it is possible for the remote firmware 

upgrade to become corrupted. This may leave the RTU inoperable. For installations of high 

criticality, it is strongly recommended that any firmware upgrades be done directly onsite using 

the RJ-45 Serial port of the WS1800. 

 

Note:  The following instructions assume the user has received the appropriate firmware file 

and latest version of the remote loader program directly from Westronic Technical Support 

prior to commencing.  

Note: Interrupting a firmware upgrade, and in particular powering down the WS1800 

during this process can result in an inoperable system.  Do not perform a firmware 

upgrade if the power to the unit may be interrupted. 

Upgrading the firmware 

To upgrade the firmware on the RTU: 

1. From the Upgrade tab, enter the correct IP and Manager port in the upper left of the 

Manager screen. Unless previously changed in the unit, the port will be the default of 

24. Connect to the RTU.  

2. Use the Get Database button to upload the configuration from the RTU to the 

Manager Screen. See Chapter 2 “ Get Database from the RTU” for more information. 

3. Then save this configuration to desktop or other file under an appropriate name to 

create a backup of the unit. See Chapter 6 “Save File” for more information. 

4. Click on the Disconnect button to disconnect Manager from the unit. 

 

 

Chapter 

5 
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5. The Loader program must be sent to the unit prior to a remote firmware upgrade. To 

do this: 

a) Ensure the IP address of the unit you wish to upgrade still appears in the box in 

the upper left of the Manager screen.  

b) Change the Port in the upper left to 23 which enables firmware to be 

uploaded to the unit (instead of a configuration file). 

c) Press the Connect button on the Upgrade window. Newer versions of firmware 

may ask for a Username and Password, older versions will simply offer an 

information box stating Username and Password are not required. 

d) Now press the Send File button (the only button that will be active on the Upgrade 

screen at this time) to begin the loading process. A window will open allowing you 

to select the Loader program from file location (wsloader100.hex or higher) and 

then click Open.  

e) A progress bar showing “Sending hex file” will appear toward the bottom of the 

Manager screen. It will take several minutes to upload this firmware.  

f) When prompted “Are you sure you want to disconnect”, click on Yes.  

6. The unit will now require a few seconds to write this to flash and reboot.  

Note: From this stage of the firmware upgrade the unit will no longer reports alarms 

until the remainder of the process is completed 

7. Ensure the correct unit IP is still in the upper left window, along with the correct 

firmware upgrade port - 23.  

8. Use the Connect button of the Upgrade tab to connect Manager to the WS1800. 

9. Although all buttons are now active on the Upgrade tab, only use the Send File button 

when wsloader has already been put on the unit. Press the Send File button. 

10. When the menu box opens, select an appropriate WS1800 Remote firmware file 

(typical file name “ws1800_253R.hex”) and press the Open button. 

11. A progress bar will open in the bottom area of the Manager screen showing various 

information titles such as “Converting File to Hex”, “Pausing 11 seconds…” and 

“Sending Firmware Segment…”. These are normal parts of the firmware upgrade 

process and must not be interfered with or interrupted. This process will take 

approximately 10 minutes.  

12. The final information lines above the progress bar are “Started Verifying firmware 

File”. After a few moments a dialog box “File uploaded Successfully” will appear. Click 

OK. 

13. Then another dialog box opens asking if you want to disconnect now, press Yes.  

14. The unit will now reboot with the new firmware.  

15. If Manager is left unattended for an extended period of time the unit will automatically 

disconnect from Manager and reboot on its own, but the disconnect message may still 

be onscreen.  

16. After waiting a few seconds for the unit to reboot, load the previously saved backup 

configuration to the Manager screen from file.  

17. Go to the Communication tab and verify whether the “Manager IP Port” is the 

standard default of 24, or if it has been changed in the configuration to some other 

port number. 



  WS1800  Manager   

994-T074 Rev A – July 2015  53 

18. Enter the correct Manger port number (24 or what now shows on the Communication 

tab) along with the IP into the boxes in the upper left of the Manager screen.  

19. Return to the Upgrade tab and press Connect.  

20. Log in with Username and Password.  

21. Press the Send Database button to resend the original configuration file back to the 

RTU. This ensures all parameters are correctly populated within the new firmware 

structure. See Chapter 2 “Send Database” for more details on this process.  

22. The firmware upgrading process has now been completed and the RTU will 

automatically return to service.  
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Other 1800 Manager Features 

 

The File Menu 

The File menu at the top of the WS1800 Manager screen offers other features not covered 

in the Manager Tabs portion of this manual.  

 

Figure 49  – Connection “Home” Tab when Manager first opened  

1.  This tab always appears as part of the default configuration when Manager is first 

opened. Figure 49 above shows the Connection Tab as a home tab when Manager is 

opened and not yet connected to an RTU. 

 

 

 

 

 

 

Chapter 

6 
 



  WS1800  Manager   

994-T074 Rev A – July 2015  59 

2. When the File menu in the upper left is clicked on the following dropdown menu 

appears: 

 

Figure 50  – The File Menu 

3. The File menu offers the following options, most of which will be covered in greater 

detail after the following outline: 

a) Load File – Enables the user to load a previously saved WS1800 

configuration file from the local PC or network and view it onscreen. It can 

then be modified, sent to an RTU and resaved under the same or new file 

name as desired. This type of file will have a “ .bin” extension on the name. 

b) Save File – This allows the user to save an onscreen configuration to the 

local PC or to a desired network location under a name of their choice. This 

type of file will have a “ .bin” extension on the filename.  

c) Import Points From CSV – This feature allows the user to share 

configurations with other WS1800 and/or to edit these in a simple, commonly 

used format. It also makes templating of units easier. Manager only Imports 

the parameters of the 16 or 32 discrete points. Files will have a “ .csv “ 

extension to their name. 

d) Export Points to CSV – This feature allows the user to share configurations 

from one WS1800 configuration to another (templating). It also gives the user 

a way to edit these points in a simple, commonly used format. Manager only 

Exports the parameters of the 16 or 32 discrete points. . Files will have a “ 

.csv “ extension to their name. 

e) Display All – If a configuration has caused some tabs of Manager to 

disappear in accordance with the license key and it is desired to view all the 

various tabs, this causes the hidden tabs to reappear. Does not affect actual 

unit configuration or license. Can only be activated when NOT connected to 

an RTU.  

f) Manager Disconnect Timeout   - Configurable from 1 to 120 minutes. By 

enabling this feature an instance of Manger that might be accidentally left 

connected to a WS1800 will automatically disconnect after the prescribed 

time.  

g) Exit – Closes WS1800 Manager. 
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Load File Function  

The Load File option from the File Menu enables the user to load WS1800 configuration 

files ( “.bin” name extension) into the Manager screen for editing and/or downloading to a 

WS1800 on the network. When the Load File option is clicked on, the following screen 

opens: 

 

Figure 51  – The Open (Load) File Menu  

 

1.  This standard menu opens up allowing the user to search their PC or the network for 

appropriate WS1800 configuration files (“.bin”). 

2. Once the desired file is located, here is “Lab unit 10.0.100.34.bin”, press Open to load 

it into the Manager Utility. Once the file has loaded the following window will appear: 

 

Figure 52  – File Loaded Successfully dialog box  

3. Click OK & proceed with modifying and/or downloading the file to the RTU as desired. 

4. Save the configuration file under an appropriate name as may be required.  
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Save File Function 

The Save File option from the File Menu enables the user to save WS1800 configuration 

files ( “.bin” name extension) from the Manager screen after editing and/or uploading from 

a WS1800 that is on the network. When the Save File option is clicked on, the following 

screen opens: 

 

Figure 53  – The Save File Menu  

1. This standard menu opens up allowing the user to search their PC or the network for 

appropriate place to store WS1800 current onscreen configuration file (“.bin”). 

2. Once the desired location is found, choose an appropriate file name. Here we are 

using “Example of saving file for Manager Manual”. Click Save. Once the save has 

completed, the following dialog box will appear: 

 

Figure 54  – Config File saved dialog box 

3. Click OK. The file is now saved on the PC or network, and continues to be available 

onscreen. 
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Import Points from CSV  

The Import Points from CSV option from the File Menu enables the user to load WS1800 

point files ( “.csv” name extension) into the Discrete Inputs tab of the Manager screen after 

editing and/or templating. They can then be downloaded to any WS1800 on the network. 

When the Import Points option is clicked on, the following screen opens: 

 

Figure 55  – The Open file (Import Points) menu 

1.  This standard menu opens up allowing the user to search their PC or the network for 

appropriate WS1800 CSV point files (“.csv”). 

2. Once the desired file is located, here is “Sample export for Manual.csv”, press Open 

to load it into the Manager Utility. Once the file has loaded the following window will 

appear: 

 

Figure 56  – The Import Points dialog box 

3. Other areas (Tabs) of the Manager screen may also require editing prior to sending 

the new point descriptions to the RTU. Alternatively, the point description may be 

loaded into another previously generated “.bin” file containing the other RTU 

parameters.  

Note:  Although just the points were updated, Manager only sends complete 

configurations to the WS1800. 



  WS1800  Manager   

994-T074 Rev A – July 2015  63 

4. If required, save the complete (new) configuration file for this RTU to PC or network 

under an appropriate file name. See Save File function above for more details. 

 

Export Points to CSV  

The Import Points from CSV option from the File Menu enables the user to load WS1800 

point files ( “.csv” name extension) into the Discrete Inputs tab of the Manager screen after 

editing and/or templating. They can then be downloaded to any WS1800 on the network. 

When the Import Points option is clicked on, the following screen opens: 

 

Figure 57  – The Export Points to CSV menu 

1.  This standard menu opens up allowing the user to search their PC or the network for 

appropriate place to store WS1800 current onscreen Discrete Point parameters as a 

CSV file for editing or templating to other units. (“.csv”). 

2. Once the desired location is found, choose an appropriate file name. Here we are 

using “CSV export example IP-99”. Click Save. Once the save has completed, the 

following dialog box will appear: 

 

Figure 58  – The Config file saved dialog box 

3. Click OK. The file is now saved on the PC or network and continues to be available 

onscreen. 
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Manager Disconnect Timeout  

The Manager Disconnect Timeout enables Manager to automatically disconnect from a 

WS1800 in a prescribed amount of inactive time. This prevents a forgotten, unattended 

instance of Manager inadvertently being linked to a specific WS1800 for extended periods, 

thus restricting anyone else from being able to provision the unit. Default of this feature is 

disabled. Clicking the Enable box enables this feature for the minimum time of 1 minute, 

up to a maximum of 120 minutes. When the Manager Disconnect option is clicked on, the 

following screen opens: 

 

 

Figure 59  – The Manager Disconnect Menu 

1. By clicking on the Enable Application Timeout box, it will be possible to change the 

timeout period and save it by clicking OK. 

2. If Manager is connected to a WS1800 and left unattended for the chosen period of 

time, the following warning will appear. In the example below the chosen timeout was 

1 minute: 

 

Figure 60  - Manager Time out in progress 

3. The timeout can either be cancelled if noticed by the user, or it will automatically 

proceed with the disconnect process. The unit will not be rebooted following an 

automatic disconnect of this type. 
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About 

The About item in the Help menu displays the 1800 Manager about window. 

1. Click on the Help area of the upper task bar and the following menu will open: 

 

Figure 61  – Using the Help button to open the About window 

2. Then click on About to see Version and other information about the current installation 

of Manager: 

  

 

Figure 62  – The WS1800 Manager About Window 

3. Click OK to close the About information window. 
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Example of a .CSV file export from Manager 

The following is an example of  a .csv Template File containing all 32 digital points as set by default in 

a WS1800. This template is in a comma separated Microsoft ® Excel file. It can also be viewed and 

formatted in a standard text editor. 

 
 

 

Figure 63  – Example of Discrete Point Export CSV file  

Appendix 

A 
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